


Dear AutoCAD and LT Designers,
 
Since 2004, I’ve published an annual compilation of my favorite time- 
saving tips and tricks to help you get the most out of your AutoCAD and 
AutoCAD LT software. Every year, I have to make tough choices on which 
tips to drop from my publication so I can make space for new tips or tricks. 
Sometimes, the lost tips and tricks are popular user-favorites, and I hear 
from many of you who want the old – but still valid – tips to come back.
 
I’ve listened to your feedback, and I’m happy to respond with this 
exclusive collection of my (and your) all-time-favorite Tips and Tricks for 
AutoCAD and AutoCAD LT.
 
Happy Designing!
Lynn Allen
Autodesk Evangelist and long-time AutoCAD expert

T H E  B E S T  O F  LY N N  A L L E N ’ S  T I P S  &  T R I C K S



U S E R  I N T E R F A C E

QUICK ACCESS TOOLBAR
Put the Layer drop-down list on the Quick Access 
Toolbar (QAT) for speedy access at all times! A simple 
right click on the layer drop down list allows you to 
easily add it to the QAT.

Feel free to add any tool from any ribbon tab that 
you use often. This saves you from having to browse 
to various ribbon tabs for favorite commands. After 
you have added your tools, the QAT also allows for 
easy customization to organize the tools that are 
placed on it.

STATUS BAR
Populate the Status bar with the tools you want by 
clicking on the three stacked lines (the “hamburger”) 
in the lower-right corner of the editor. The Status bar 
will automatically wrap onto two rows when the icons 
can’t fit into a single row.

TIP:  Add tools to the QAT 
for temporary tasks and 
when you are done with 
those tools, simply right 
click and remove.



FILE TABS
File tabs display in the order they were opened, but 
you can easily drag and drop them to change the order. 
If you run out of room—an overflow menu will appear 
to the right.

Passing the cursor over a file tab will display preview 
images of model space and layouts. If you hover over a 
preview image the preview is temporarily enlarged and 
displayed in the drawing area.

NOTE: A lock icon on a tab indicates read-only; 
an asterisk indicates the file has been modified 
since the last save.

If for some reason you prefer to turn off this cool new 
tool—you can do so from the File Tabs control on the 
View tab of the ribbon.

Right click on the file tabs to reveal additional options 
such as Save All and Close All.  Use Copy Full File Path to 
quickly copy a link to your drawing for an email or use 
Open File Location as a friendly directory reminder.

File Tab right-click menu

U S E R  I N T E R F A C E

Plot and Publish

*	File has been modified 	
	 since the last save

Preview Close drawing

New drawing

TIP:  You can even print/publish 
a layout from the preview!



U S E R  I N T E R F A C E

GALLERIES
The block galleries make it easy to view and insert 
blocks directly from the ribbon (current drawing only). 
You’ll also find helpful galleries for styles such as 
dimensions, mleaders, text, tables and table cells.

MODEL SPACE VIEWPORTS
Model Space Viewports are easier to identify and easier 
to resize. Simply drag the horizontal or vertical viewport 
boundaries by the handles, or the intersection to resize 
them.

The + icon lets you easily add more viewports…
simply click and drag the + icon and release at the 
proper size.

You can also create a new viewport by holding CTRL 
while dragging.

TIP:  You can join or remove a viewport 
by dragging a boundary to the edge.



HELP
Can’t find a tool? While in the Help window, click on the 
Find link and an animated arrow will point to the tools’ 
location in the Quick Access Toolbar, Ribbon, Status bar, 
or Application menu.

If you are new to AutoCAD, make sure to check out “The 
Hitchhiker’s Guide to AutoCAD Basics” which is located 
in AutoCAD’s Help menu as well as the Start tab. Simply 
press F1 to open the Help menu.

DIALOG BOX ENHANCEMENTS
Many dialog boxes now have the ability to be resized 
while maintaining their size the next time you launch 
AutoCAD. With these enhancements you can view more 
information with less scrolling. Just try resizing the 
Insert dialog box for inserting blocks. The block preview 
resizes along with the dialog box giving you a better 
preview of the block!

LAYOUTS
You’ll appreciate the layout preview thumbnails and 
the handy + symbol to quickly add a new layout. For 
those of you who like to heap on the layouts—you’ll 
like the overflow menu for easy access to layouts 
that extend beyond the width of the display.

NOTE: You can control the paper background color 
in Options.

U S E R  I N T E R F A C E



C O M M A N D  L I N E

The command line has had quite a facelift and 
functionality boost over the last couple of years. 
Here are some tips that I’m sure you’ll find helpful.

FLOATING COMMAND LINE
By default, the command line is in a floating mode 
which means that it can be moved and placed anywhere 
on your screen or on another screen.

SYNONYM SUGGESTIONS
When you work on multiple CAD systems— it is easy 
to get your nomenclature mixed up! The Synonym 
suggestions will help you find an appropriate match 
(and it’s customizable!) For example if you key in 
SYMBOL, AutoCAD will offer up the INSERT command.

SELECTABLE OPTIONS
Command options are displayed on the command line in 
blue to make these options more visible. You can even 
click on the option instead of typing it in!

Customize your synonyms with the Edit Synonym List 
tool (Manage ribbon tab).



CONTENT
Timesaver alert! Now you can access layers, blocks, 
hatch patterns, text styles, dimension styles and visual 
styles from the command line! For example, if you key 
in “Door”, you can quickly insert the preferred door 
block from the suggestion list.

AUTOCORRECT
No more of the dreaded “unknown command”! Now 
if you mistype a command, AutoCAD will autocorrect 
to the most relevant command. (Hoorah!)

AUTOCOMPLETE
Save time (and spelling frustration) with AutoComplete! 
As you key in commands, AutoCAD automatically 
completes the entry. If you pause, a list of all possible 
commands and system variables displays for easy 
selection. AutoComplete also supports mid-string 
search capabilities. If you key in “PLANE” for example, 
you will get all the commands and/or system 
variables that contain the word PLANE.

Commands in the AutoComplete suggestion list are 
initially displayed in order of their general popularity. 
As time goes on—the suggestion list will adapt to your 
own usage behavior (making your AutoCAD smarter 
and smarter!).

TIP:  With all these new command line options 
—you will find some are displayed with expand-
able categories. Simply select the + or use 
the tab key to cycle through all the content.

C O M M A N D  L I N E



O B J E C T  S E L E C T I O N

LASSO SELECTION
Click and drag your cursor to use the versatile 
Lasso selection—click and release for the traditional 
rectangular selection.

Hit the spacebar to cycle between window, crossing 
and fence options.

NOTE: This behavior can be turned off in 
the Selection tab of Options.

SELECTION CYCLING
Working in a crowded drawing? Easily select overlap-
ping objects with the Selection Cycling tool (controlled 
on the status bar). When you hover over objects that are 
stacked or overlapped, you will see a Selection Cycling 
badge next to your cursor. When you select an object 
that overlaps other objects, AutoCAD displays a list of 
all the overlapping objects. Objects highlight as you 
move through the list.

UCS ENHANCEMENTS
The UCS icon is now selectable (not with window or 
crossing selections). You can directly manipulate the 
UCS icon using multi-functional grips. Easily move and 
align the origin with objects (including curved surfaces 
and solids). Select the UCS icon and choose from the 
various menu options that appear as you hover over 
the grips.

NOTE: UCS icon selectability can be controlled in the 
UCS dialog box (Coordinates panel, Home ribbon tab in 
the 3D Modeling workspace) or by using the command 
DDUCSP

Selection Cycling icon on the Status Bar



R I G H T - C L I C K  M E N U

SELECT SIMILAR
The Select Similar tool allows you to quickly select 
objects of the same type and properties (much faster 
than Quick Select). Find this tool in the right-click menu 
when one or more objects are selected.

Use the Settings option to specify which properties to 
filter (only available when you enter SELECTSIMILAR 
from the command line).

ADD SELECTED
Need to draw an object with the same type and proper-
ties as an existing one? Use the Add Selected tool to get 
the job done in no time! For example, select a polyline, 
pick Add Selected from the right click menu and Auto-
CAD is ready to create another polyline with the same 
properties. This is a HUGE timesaver!

TIP:  You can select more than one object to 
match with Select Similar. For example, if the 
Layer filter is enabled and you select a circle and 
a line that reside on two different layers, Auto-
CAD will find all of the objects that match the 
circle AND all of the objects that match the line.

TIP:  Very helpful when working on other 
people’s drawings! For example: use Add 
Selected to quickly add in another dimension 
with exactly the same style and settings.



OBJECT VISIBILITY
Control object visibility independent from layer 
visibility! The Isolate Objects tool (found in the right-
click menu) displays only the selected objects (every-
thing else is hidden). This makes it easier to work 
within complicated drawings. You can use the Hide 
Objects tool (also found in the right click menu) 
to hide the objects selected. Quickly restore the 
hidden objects with the End Object Isolation tool.

The shapes icon in the lower right corner of the 
status bar indicates whether objects are being 
hidden or isolated in the drawing.

NOTE: Use the OBJECTISOLATIONMODE (yikes!) 
system variable to control whether object isolation 
persists between drawing sessions.

Blue circle indicates that object 
isolation is being used.

All gray shapes indicate that 
object isolation is not in use.

TIP:  These tools can be VERY 
valuable when working in 3D!

R I G H T - C L I C K  M E N U



E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S

REVISION CLOUDS
If you draw revision clouds, you're going to love the 
updated REVCLOUD that is easy to edit using grips 
(no more stretched, elongated arcs!!) REVCLOUD 
also supports rectangular, polygonal and freehand 
(and Object from the command line).

Have you ever wanted to combine revision clouds? Use 
the Modify option to create an additional revision cloud 
and delete selected portions of an existing revision 
cloud (put more than one revision cloud together).

NOTE: Set REVCLOUDGRIPS to OFF to put grips 
back to legacy behavior

COPY
Use the handy Array option in the Copy command 
to create a linear (non-associative) array on the fly. 
There’s even a Fit option that lets you array between 
two points!

QUICK MOVE AND COPY
Need to make a quick copy or move objects? Simply 
select the objects first, then right click and hold the 
right mouse button. When you let go, you will have 
the options shown below.

BLEND TOOL
Use the BLEND tool to create a spline that connects 
two objects. The spline created is tangential from 
the selected objects. So much better than PEDIT!

TIP:  Set your preferred default
with REVCLOUDCREATEMODE



EXPRESS TOOLS BECOME “REAL” COMMANDS
The NCOPY Express Tool is now a core AutoCAD 
command. Copy nested objects from Xrefs, blocks 
and DGN underlays (no need to explode or bind)!

Use the Delete Duplicates tool (OVERKILL command) to 
clean up your drawing and remove duplicate geometry.

ISOMETRIC DRAFTING ENVIRONMENT
Use the Isodraft tool on the status
bar to switch the snap style to
Isometric and move from one
isometric plane to another.
Kill two birds with one stone!

JOIN
Looking for a way to clean up your drawing? You can 
join lines, arcs and polylines to 3D polylines or splines 
as long as they are contiguous. You can also join a 
helix to a spline.

ARCS
AutoCAD loves to draw arcs that are counterclockwise.  
Use the Ctrl Key to switch arc directions!

NUDGE
Have you ever wanted to move objects over by just 
a few pixels? Try using Ctrl plus your arrow keys!

+

TIP:  JOIN now supports standard selection 
methods (such as crossing or all) or picking 
objects in any order!

E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S



E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S

MULTIFUNCTIONAL GRIPS
Multifunctional Grips exist on so many different objects! 
Editing commands reside with the object (which means 
less time searching).

Look for these powerful grips in lines, plines, arcs, 
elliptical arcs, dimensions and multileaders. 3D faces, 
edges and vertices also have them. Just hover over 
a grip to access numerous relevant options.

DYNAMIC INPUT
By using dynamic input, the power of the command line 
conveniently follows your cursor, the ability to define 
angles while drafting (without using Polar Tracking) 
and the power to inspect lengths of linear geometry 
and the radius of curved geometry like an arc.

•	 To access sub-options in a command, simply hit 
	 the down arrow on the keyboard then click select 
	 the option from the list.
•	 Dynamic input is great for drawing at angles. Just 
	 use the tab button to switch between defining lengths  
	 and angles and back again. All without needing to 
	 use Polar Tracking. 
•	 You can easily inspect geometry without placing  
	 dimensions or by using the MEASUREGOEM command.  
	 Select the object that you want to inspect, then hover  
	 over a grip to display temporary dimensions show the  
	 angle and length of a line, the Radius and degrees of  
	 an arc and radius of a circle.

TIP:  Multifunctional grips are even more 
powerful when dynamic input is turned on.

Shown below are various shapes and their measurements when using Dynamic Input

Command 
Options

Length Angle



QUICKCALC
A handy calculator derived from the Geometric 
Calculator command (CAL), QUICKCALC can be used to:

•	 Perform a full range of calculations
•	 Convert from one system of units to another 
•	 Perform more advanced functions 
	 with the Scientific panel
•	 Pass values back and forth to a command 
	 or the Properties palette
•	 Set variables for use across AutoCAD 
	 drawings and sessions

E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S

COMMAND PREVIEW
Preview the results of so many editing commands 
including Blend, Erase, Break, Rotate and Scale.

NOTE: The Command Preview control on the Selection 
tab of Options enables/disables this cool feature.

STRETCH
The STRETCH command can be your best friend if you 
remember these simple rules: Using a crossing selec-
tion (green box); anything that is completely inside 
the crossing selection will be moved, anything that the 
edges of the crossing selection touch will be stretched.

FILLET AND CHAMFER
Previews display when passing the cursor over the 
second object in the Fillet/Chamfer commands. Confirm 
and change the radius or distance before completing 
the command!

NOTE: Now you can fillet splines. You can also fillet 
or chamfer a polyline or polyarc to itself!

Polyline

Before Fillet After Fillet



PDF ENHANCEMENTS
You’ll find the updated PDFs in AutoCAD are slimmer 
and faster! More font types including SHX) are fully 
supported. That means that more text can be 
highlighted, copied, and searched.

Export to DWF™ and Export to PDF options 
have been split, and they each have their 
own Export Options dialogs.

IMPORT PDFS
With the PDFIMPORT command, you can import the 
geometry, TrueType text, and raster images from 
a specified page in a PDF file, or from all or part 
of an attached PDF underlay.

Four different predefined PDF options can be 
found when plotting, so you can easily select 
the one to suit your needs.

ASSOCIATIVE CENTER 
MARKS & CENTERLINES
Use these tools to place lines 
at the center of circles and 
arcs or between two lines and 
polylines. These objects are 
associative which means that 
when you make changes to 
the geometry, the centerlines 
and center marks will go along 
for the ride and automatically 
update!

PDF export options for
hyperlinks and bookmarks 
have been added.

PDF Import on the PDF 
Underlay contextual ribbon

Insert ribbon > Import panel > 
Import dropdown list

TIP:  Use hyperlinks to link sheets, named 
views, external websites, and files (or from 
objects such as images, blocks, fields, etc.).

E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S



E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S

TRANSPARENCY
You can assign transparency 
to objects and layers much 
like any other property! Set 
the transparency to a value 
between 0 and 90. 0 indicates 
no transparency while 90 
indicates high transparency.

You’ll find the Transparency 
property in all the Layer 
dialogs and you can even 
assign transparency per 
viewport.

If you set transparency per object - it will override the 
layer transparency setting. Transparency can be easily 
found in Properties or on the Home tab.

NOTE: SETBYLAYER, Quick Select, Filter and MATCH-
PROP now include Transparency as an option.

You can temporarily turn off transparency, much like 
lineweights, from the status bar (this does not affect 
plotting). 

NOTE: By default Transparency is turned off for plot-
ting (since it has to rasterize the drawing which slows 
down plotting). Don’t forget to turn it on if you want 
your transparencies to plot!

TIP:  The system variable CETRANSPARENCY 
can be used to set the transparency property 
for new objects.

TIP:  Transparency works 
great with solid hatches!



PATH ARRAYS
Use the Path option in the ARRAY command when 
you want to evenly distribute objects along the entire 
length of a path.

The item count toggle allows you to indicate a specific 
number of items to be arrayed, or to fill the path with 
the items. When off, an additional grip at the end of 
the array appears to provide dynamic editing.

RECTANGULAR AND POLAR ARRAYS
The visual preview makes it easier than ever to get 
your array correct the first time. Rectangular arrays 
are automatically displayed in a 3 row by 4 column 
grid. Polar arrays are displayed in a full circular 
pattern of 6.

The multifunctional grips can be used to quickly 
increase/decrease the number of rows or columns—
or to control the spacing between the rows 
and columns.

E V E R Y D A Y  C O M M A N D  I M P R O V E M E N T S



T E X T

Many new tools have been added to the MTEXT editor to 
make it easier than ever for you to get your annotations 
done faster.

MATCHPROP
Use the Match Properties tool in the Text Editor ribbon 
to apply properties between selected text within an 
Mtext object.

CHANGE CASE
Easily change highlighted text to either 
upper or lower case from the dropdown menu.

BACKGROUND MASK
Mtext background mask remembers the last used fill 
color and offset. (No more defaulting to red and 1.5!) 

SUB/SUPERSCRIPT
Highlight the text and use the Superscript/Subscript 
tools on the ribbon

STRIKETHROUGH TEXT
You can strikethrough mtext, multileaders, dimensions 
and tables.

TIP:  Works with dimensions and tables too!

BULLETS AND NUMBERING
Mtext now has automatic bullets and numbering. Begin 
a line with a symbol, number or letter followed by one 
of these symbols: . , ) > } , ] and then a tab to create a 
bullet or numbered list. Click the lightening bolt icon 
for more options. If you have a gap or interruption in 
your numbered/lettered list, pick up where you left 
off by typing in the next successive number or letter 
and hit the Tab button.

NOTE: Use the Backspace button to remove automatic 
bullets and numbering.



TEXT ALIGNMENT
The TEXTALIGN command quickly lines up 
your text to existing text (or by selecting points). 
You can easily control the spacing or alignment
direction.

T E X T

DRAW ORDER
Control the draw order of individual or global 
annotation objects.



D I M E N S I O N S

SMART DIMENSIONING
Let AutoCAD take the tedium out of dimensioning! 
The updated DIM command is smart enough to detect 
objects and provide various visual dimension options. 
You can even specify a default dimensioning layer 
(only valid when using the DIM command).

Use the DIMLAYER command to assign or create 
a new layer for dimensioning.

The DIM command remains active until you exit the 
command, so you can knock out multiple dimensions 
at one time. All of the dimensions shown in the image 
below were created using the single DIM command! 

SMART DIMENSION BREAK COMMAND
The DIMBREAK command breaks dimension or exten-
sion lines where they intersect objects or other dimen-
sions. The breaks automatically update if you move the 
intersecting objects—even if they no longer intersect! 
You can also use the Restore option to remove
all breaks.

UPDATED DIMCONTINUE & DIMBASELINE
Set the new system variable DIMCONTINUEMODE to 1 
to create Continued and Baseline dimensions with the 
same dimension style as the base dimension (regard-
less of your current layer!) 

SPLIT DIMENSIONS
If you attempt to create an overlapping dimension you’ll 
see options to move, break up, or replace the existing 
dimension.

NOTE: No more snapping to extension lines by 
accident! Object snaps ignore extension lines when 
creating dimensions. Control this behavior on the 
Drafting tab of Options.

TIP:  DIMBREAK also works on multileaders.



L A Y E R S

NATURAL ORDER SORT FOR LAYERS
If you number your layers, you’ll be thrilled with 
this improvement! Now numbered layers are sorted 
in their natural order such as:
1, 2, 4, 6, 10, 21, 25 (as opposed to 1, 10, 2, 25, 21, 4, 6).

LAYER MERGE
LAYMRG has been incorporated in to the Layer Manager. 
Right click to merge 2 or more layers together onto one 
layer (and automatically delete the now empty layers).

SETBYLAYER
This is a fantastic command to set objects (including 
those within nested blocks) back to BYLAYER!

VIEWPORT LAYERS
Use the right-click menu in the Layer Properties 
Manager to quickly freeze specified layers in all 
viewports except the current one. (Handy!)



RECOVER DRAWINGS ALONG WITH XREFS
This drawing utility allows you to run the recover pro-
cess on a drawing and all of the associated xrefs. Find 
this capability under the Application Menu > Drawing 
Utilizes > Recover with XREFs

ATTACH & OVERLAY SWITCH
Toggle between Attach and Overlay in the XREF 
Manager with a simple double-click.

XREF FILE PATH
Edit the Saved Path directly in the External References 
palette (Found path is read-only). Relative Path is the 
default (unless the relative path is not available).

XREF LAYERS
XREF layers no longer display in Properties 
and are grayed out in the Layer dropdown list 
(since you can’t pick them anyway!).

XREF LAYER DISPLAY
Control the display of layers from xref drawings 
(even if they’re not set to Bylayer in the host drawing). 
Set XREFOVERRIDE to 1 and xref objects will take on 
Bylayer behavior.

X R E F S



3 D

3D ORBIT
Enjoy better control of the target point when you turn 
off “Enable Orbit Auto Target” from the 3DOrbit right 
click menu. Then you can click and hold the cursor to 
specify the pivot point.

SURFACE CURVE EXTRACTION
Use the Extract Isolines tool (Surface ribbon tab) to 
quickly extract isoline curves from an existing surface 
or face of a solid.

You can change the direction of the isolines, select 
a chain or draw a spline on the curved surface.

PRESSPULL
Use the Multiple option or the Shift key to press/pull 
multiple objects in a single operation. Now you can 
select 2D and 3D curves as well!

A small spherical icon will display to indicate 
the pivot point.

TIP:  Use the Ctrl key when you select a 
planer face to offset it as it extrudes to 
follow the taper angles of adjacent sides.



3 D

SECTION PLANE
The Section Plane tool, which creates a cutting plane 
through 3D objects, now works on point clouds.

Slice generates a thin cut through the model with 
parallel front and back section planes. It has a 
thickness property (but no jogs allowed).

Choose between a simple cutting plane, a slice, 
or a bounded or volumetric area for your section 
object type.

The contextual Section Plane tab is filled with more 
section plane controls, including a Live Section toggle, 
the ability to add jogs, generate section blocks from 
solids, and extract section lines from point clouds.



Lynn Allen, Cadalyst columnist and worldwide Autodesk 
Technical Evangelist, speaks to more than 30,000 users 
each year. For the past 23 years she has written a column 
in Cadalyst magazine called “Circles and Lines” and is the 
voice behind Cadalyst’s “Tips and Tricks Tuesdays.” Lynn 
started using AutoCAD software with Release 1.4, over 25 
years ago, and got her start by teaching at the corporate 
and collegiate level for 12 years. A sought-after public 
speaker with a unique comedic style, Lynn has served 
as the Autodesk University host for more than 10 
years and is always one of the highest-rated 
speakers. Her latest book is entitled AutoCAD 
Professional Tips and Techniques.
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